
Version 3.10

Version 3.10Version 3.10Version 3.10Version 3.10.7





Table of Contents

1 Welcome to SAG10 ............................................................................................. 1
1.1  What is SAG10? .......................................................................................................... 1 
1.2  Who can use SAG10? .................................................................................................. 1 
1.3  SAG10 Highlights ........................................................................................................ 1 

1.3.1  SAG10 features ........................................................................................................ 1 
1.3.2  What’s new in SAG10 v3.10? ................................................................................. 2 
1.3.3  History of SAG10 and the Graphic Method ............................................................ 3 
1.3.4  Future Directions for SAG10 ................................................................................... 3 

1.4  Installation.................................................................................................................... 4 
1.4.1  Your Southwire SAG10 package includes: ............................................................. 4 
1.4.2  Minimum system requirements ................................................................................ 4 
1.4.3  Installation – single user .......................................................................................... 4 
1.4.4  Installing and using SAG10 on a network ............................................................... 5 
1.4.5  Installation of SAG10 on a network server.............................................................. 5 
1.4.6  Installation of SAG10 on a workstation .................................................................. 5 
1.4.7  Using SAG10 on a network ..................................................................................... 6 
1.4.8  Printing over a Network ........................................................................................... 6 

1.5  Known Issues ............................................................................................................... 7 
1.6  Technical Support ........................................................................................................ 7  

2 Getting Started with SAG10 ............................................................................... 9
2.1  Create a project file ...................................................................................................... 9 
2.2  Select the conductor ................................................................................................... 10 
2.3  Enter the ice/wind load and tension limits ................................................................. 11 
2.4  Enter the Ruling Span lengths .................................................................................... 12 
2.5  Calculate sag and tension ........................................................................................... 14 

3 Main Menu toolbar controls ............................................................................. 16
3.1  File menu ................................................................................................................... 16 

3.1.1  New ........................................................................................................................ 16 
3.1.2  Open ....................................................................................................................... 16 
3.1.3  Save ........................................................................................................................ 16 
3.1.4  Save As .................................................................................................................. 16  
3.1.5  Exit ......................................................................................................................... 16 

3.2  Run menu ................................................................................................................... 16 
3.2.1  Sag & Tension........................................................................................................ 16 
3.2.2  Pause between Spans ............................................................................................. 16 
3.2.3  Inclined Spans ........................................................................................................ 17 
3.2.4  Ruling Span Calculation ........................................................................................ 18 

3.3  Tools – Options menu ................................................................................................ 20 
3.3.1  Elevated Temperature ............................................................................................ 21 
3.3.2  Input and Output tensions ...................................................................................... 24 
3.3.3  Other (Estimated Cast Rod Creep) ........................................................................ 26 
3.3.4  Optional Columns in Output .................................................................................. 26 
3.3.5  Units ....................................................................................................................... 27 
3.3.6  NESC K ................................................................................................................. 27 

.7?



3.3.7  Creep (time selection) ............................................................................................ 28  
3.3.8  Also Output Results to ........................................................................................... 28 
3.3.9  Folder Path setups .................................................................................................. 28  
3.3.10  Stress-Strain Curves ........................................................................................... 29  
3.3.11  Send To File ....................................................................................................... 29 

3.4  Tools – Chart Explorer............................................................................................... 29  
3.5  Setup menu................................................................................................................. 31  

3.5.1  Print setup .............................................................................................................. 31  
3.5.2  Page setup .............................................................................................................. 32  
3.5.3  Fonts ....................................................................................................................... 33 

3.6  Help menu .................................................................................................................. 33  
3.6.1  Help Contents function tabs ............................................................................. 34 
3.6.2  Help Search for Help On … ............................................................................... 34 
3.6.3  Help Tech Support ............................................................................................. 34 
3.6.4  Help View License ............................................................................................. 35 
3.6.5  Help About SAG10 ............................................................................................ 35 

4 Conductor Selection Screen ............................................................................ 37
4.1  Conductor Type ......................................................................................................... 38  
4.2  Conductor or Messenger Box .................................................................................... 39  
4.3  Data Panel .................................................................................................................. 39 

4.3.1  View Chart ............................................................................................................. 40  
4.3.2  Editing conductor data ........................................................................................... 40  

4.4  Conductor options ...................................................................................................... 41  
4.4.1  TP (Twisted Pair) option ........................................................................................ 41  
4.4.2  Use as a Messenger ................................................................................................ 42  
4.4.3  Non-supporting cable, pre-assembled or lashed .................................................... 43  
4.4.4  Marker Balls........................................................................................................... 44  
4.4.5  PLP Spoiler ............................................................................................................ 45  
4.4.6  ADSS Cable ........................................................................................................... 46 
4.4.7  OPGW cable .......................................................................................................... 47  
4.4.8  AAAC conductor ................................................................................................... 47  
4.4.9  3M ACCR conductor.............................................................................................. 47
4.4.10 ACSR/TW Codewords........................................................................................... 47

 

4.5  Sort Options ............................................................................................................... 47  
5 Edit Loading Table Screen ............................................................................... 49

5.1  Load Table fields ....................................................................................................... 50  
5.2  Load Selections .......................................................................................................... 50  

5.2.1  NESC ..................................................................................................................... 50  
5.2.2  Customary .............................................................................................................. 51  
5.2.3  California ............................................................................................................... 52  

5.3  Gallop Load ............................................................................................................... 53  
5.4  Creep Load ................................................................................................................. 53  
5.5  Printing the Load Table ............................................................................................. 53  

6 Sag & Tension Data Screen ............................................................................. 55
6.1  Data screen ................................................................................................................. 55 
6.2  Creep messages in the Data Screen ........................................................................... 55  

6.2.1  Extrapolated curve message. .................................................................................. 55  



6.2.2  Creep messages and critical tension ...................................................................... 55 
6.3  Data Screen upper toolbar controls ............................................................................ 56 

6.3.1  Action ..................................................................................................................... 57 
6.3.2  Edit ......................................................................................................................... 57 
6.3.3  View ....................................................................................................................... 57 
6.3.4  Stringing module .................................................................................................... 59 
6.3.5  Offset Clip module ................................................................................................. 61 
6.3.6  Ruling Span Variation module ............................................................................... 63 
6.3.7  Gallop module ........................................................................................................ 64 
6.3.8  Clash module ......................................................................................................... 68 

6.4  Data Screen lower toolbar controls ............................................................................ 72 
6.4.1  Return ..................................................................................................................... 72 
6.4.2  Print ........................................................................................................................ 72 
6.4.3  Save ........................................................................................................................ 73 
6.4.4  Copy ....................................................................................................................... 73 
6.4.5  Edit ......................................................................................................................... 73 
6.4.6  Explore ................................................................................................................... 73 

Consumer End Users Only..................................................................................................... 74 
7 SAG10 Software End User License Agreement ............................................. 75

7.1  Definitions.................................................................................................................. 75 
7.2  License(s) ................................................................................................................... 75 
7.3  License Restrictions ................................................................................................... 76 
7.4  Upgrades .................................................................................................................... 76 
7.5  Ownership .................................................................................................................. 77 
7.6  Limited Warranty and Disclaimer ............................................................................. 77 
7.7  Exclusive Remedy ..................................................................................................... 77 
7.8  Limitation of Liability ................................................................................................ 78 
7.9  Basis of Bargain ......................................................................................................... 78  
7.10  (Outside of the USA) Consumer End Users Only ..................................................... 78 
7.11  General Provisions ..................................................................................................... 78 
7.12  Third Party Software .................................................................................................. 79 

8 Appendix - Reference materials ...................................................................... 81



Welcome to SAG10

What is SAG10? 

Who Can Use SAG10? 

SAG10 Highlights 

Installation 

Known Issues 

Technical Support 



1  Southwire Sag10 User’s Manual v3.10 

1 Welcome to SAG10  

1.1 What is SAG10?  
Southwire SAG10 is a PC-based program that automates execution of the Alcoa Graphic 
Method of sag-tension calculations for overhead conductors. The Alcoa Graphic Method 
has been the standard for sag and tension calculations for over 80 years. 

1.2 Who can use SAG10?  
Southwire intends the SAG10 program to be used by qualified engineers and designers 
who have a foundation of knowledge about overhead power transmission and distribution 
lines, and the performance of conductors used in those lines. When using SAG10, a 
qualified engineer should review the parameters input for the calculations, and the 
resulting calculated data, and verify that they are correct for the specific application. 

1.3 SAG10 Highlights  

1.3.1 SAG10 features  
SAG10 calculation features include:  
• Alcoa graphic method of sag and tension calculation  
• Sag and tension with creep
• Elevated temperature creep  
• Inclined span calculation  
• Stringing sag calculation 
• Offset clipping  
• CLASH module for calculating clearance between conductors and ADSS conductor 
• Galloping calculations 
• Ruling Span variation calculations 

Other SAG10 features include:  
• Easy-to-use menu-driven interface 
• Capability to Create, Save, and Open project files
• Basic ice and wind loading tables, as well as the ability to create, edit and save 

custom loading tables.  
• Editable tension limits  
• Ability to easily create, save, and edit custom conductors  
• Automatic creep check  
• Easy modification of the temperatures displayed in the outputs
• Extensive conductor database, including stress-strain chart associations  
• Graphic Output of Galloping Ellipses and Sag Curves  
• Ability to add attachments and supported loads to conductors  

Data furnished includes:  
• Stress-strain coefficients  
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• Conductor database including:  
o AAC 
o AAAC 
o ACAR  
o ACSR 
o ACSR/AW
o ACSR/TW 
o ACSR/SD 
o ACSS 
o ACSS/TW 
o ACSS/AW
o All-Alumoweld 
o Steel
o All-Copperweld
o Copperweld - Cu 
o HD Copper 
o Multiplex 
o Covered Line Wire 
o ADSS 
o OPGW
o Custom
o AAC British 
o AAAC British 
o ACSR British  
o 3M ACCR  

1.3.2 What’s new in SAG10 v3.10?  
• Free-form heading editing  
• Ability to customize the Page Setup heading to include your Company Name on 

data output
• Conductor data loads automatically when a conductor is selected  
• Customized conductors can be edited, saved, and deleted from the Custom 

conductor file 
• A completely redesigned, simpler, and more intuitive user interface 
• Conductor types are grouped for easier selection 
• Easier creation and editing of custom conductor data  
• Simplified and centralized selection of conductor attachments  
• Main screen has been enhanced so loadings and ruling spans can be entered 

without having to access additional screens 
• Data output format has been improved 
• All data required to run a stringing calculation is now entered on one screen 
• The selected Options can now be saved 
• Improved flexibility in saving and deleting custom conductor data for individual 

or multiple projects  
• Enhanced loading table editor  
• Updated conductor data  
• Improved performance and reliability 

Southwire Sag10 User’s Manual v3.10.6
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1.3.3 History of SAG10 and the Graphic Method  
The Alcoa Graphic Method of sag-tension calculations was developed in 1926 by H. H. 
Rodee. The Alcoa Graphic Method is based on analysis of the stress-strain behavior of 
the complete conductor and its component parts. The method is useful for steel core 
conductors such as ACSR and ACSS, as well as conductors composed of a single metal 
such as aluminum, copper, or steel.  

In 1963, a mainframe-based program named SAGTEN became available to automate 
execution of the extensive calculations required by the Alcoa Graphic Method. In 1994, 
developers released SAG10, a PC-based enhancement of the original mainframe-based 
SAGTEN.  

In 2008, Southwire Company acquired ownership of the SAG10 program. In Version 
3.10, Southwire completely redesigned the SAG10 user interface to simplify use of the 
program. Southwire also made many other enhancements to improve the accuracy and 
reliability of SAG10. However, this release is simply an upgrade of the existing SAG10 
software. Further development of the SAG10 software will continue under Southwire, 
with a new version already in the planning phase.

Release history:  
1992, SAG10 Version 5 and SAGPLOT Version 1  
1994, SAG10 for Windows  
1997, SAG10 for Windows Version 1.1  
1998, SAG10 for Windows Version 2.0 
2001, SAG10 for Windows Version 3.0.  
2008, SAG10 for Windows Version 3.10 from Southwire  

1.3.4 Future Directions for SAG10 
Southwire is proud to offer SAG10 to the Transmission and Distribution market, and we 
are committed to improving and expanding SAG10 usability and benefits. In keeping 
with that commitment, we have already begun planning the first Southwire version of the 
SAG10 software.  

As a leading innovator in the industry, many Southwire developments have come through 
its partnership with its Transmission and Distribution customers. That’s why we want to 
hear from you to help us grow and improve SAG10 even further.  

Please visit www.sag10.com/feedback and tell us what you like, what you dislike, and 
what you would like to see added to future releases of SAG10. Help us to continue to 
provide you the best sag and tension tool possible. 
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1.4 Installation  

1.4.1 Your Southwire SAG10 package includes: 
1. Installation Guide 
2. License Agreement 
3. Installation CD-ROM with Registration number 
4. Printed copy of the Users Manual. For the latest version of the manual, visit our 

technical support page on the web at www.sag10.com/support
5. Complimentary copy of the Southwire Overhead Conductors Manual 

1.4.2 Minimum system requirements  
• Pentium 1.2 GHz or greater with at least 128 MB of RAM. 
• Microsoft Windows XP or higher.  
• CD-Rom drive 
• Hard disk with at least 40 MB of free space (5 MB used by program for file storage). 
• VGA or better monitor 

1.4.3 Installation – single user 
----------------------------------------------------------------------------------------------------------

NOTE 
If you are upgrading from a previous version of SAG10, any custom 
conductors and charts will have to be re-entered after installing the new 
version of SAG10. You should print copies of any custom data before 
uninstalling any prior versions of the software that you wish to enter into the 
new version. It was necessary to change the way custom data is entered to 
correct some issues in prior versions of SAG10.

---------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------
NOTE 

See the Installation Guide provided with your CD for detailed installation on 
the installation process. 

---------------------------------------------------------------------------------------------------------

1. Uninstall all previous versions of SAG10. 
2. Close any open applications running in Windows. 
3. Insert SAG10 CD-ROM into the CD-ROM drive. 
4. If the Startup Menu does not launch automatically locate the file StartUpMenu.exe on 

the CD-ROM and open the file. 
5. From the SAG10 Startup Menu, pick Install SAG10 3.0. 
6. Follow the installation screen prompts.  
7. When setup is complete, click the Finish button. 

Southwire Sag10 User’s Manual v3.10.6
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8. Any additional instructions that were too late to put in this manual will be stored in a 
file named README.1ST. The instructions may be viewed from the CD-ROM 
Menu, Windows Notepad, or any text editor or word processor. 

You are now ready to proceed to Chapter 2 Getting Started with SAG10.

1.4.4 Installing and using SAG10 on a network 
On a network, many users can share the SAG10 program and data files. Once SAG10 is 
set up on the network, the program can be run from the network server, or it can be 
installed onto the hard disks of individual workstations. This document assumes that you 
know how to use network software to connect to network drives and how to find files 
stored on network computers. 

---------------------------------------------------------------------------------------------------------
NOTE 

Every SAG10 user must either have a SAG10 Single User License, or the 
user's company must have a LAN/Client Server license or a Site License. 

---------------------------------------------------------------------------------------------------------

Before you set up SAG10 
The network must be operational, and you must have read-write access to the network 
directory in which you want to install SAG10. For more information, contact your 
network administrator. 

Setting up SAG10 on a network is a two-step process. You first install SAG10 on the 
network server. Then you set up the workstations, either by setting up the workstations to 
run SAG10 from the server or by installing SAG10 on each workstation's hard disk. 
Note: Each workstation should have at least 128 MB of RAM in order to run the SAG10 
program. 

1.4.5 Installation of SAG10 on a network server 
Follow steps 1 thru 5 for Installation - Single User, with the exception that the drive is 
likely to be some letter higher than C:, such as R:\Sag10Net3\. 

Although the SAG10 program directory on the server (the directory containing 
Sag10w3.EXE) can be either read-write or read-only, you should make it read-only after 
installing SAG10 to prevent users from unintentionally overwriting files. For more 
information, see your operating system documentation. 

1.4.6 Installation of SAG10 on a workstation 
You can install SAG10 onto local workstations so that users run the program from the 
network server, or you can install so that users run the program from their local 
workstation's hard drive. You perform the following procedures from the local 
workstation on which you are installing SAG10. 
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1. Follow steps 1 thru 5 for Installation - Single User at each workstation licensed 
to use SAG10. This will place the appropriate files in the \Windows\System 
directories for each workstation. 

2a If the user intends to access SAG10 from his own hard disk, and use the network 
only for printing and plotting and perhaps sharing common Project files, then the 
installation is complete. 
-or-

2b If the user intends to access SAG10 from the network drive, then perform the 
steps below. 

3. In Windows Explorer, Pick Start, Programs and highlight SAG10 from the list. 
4. Click on the right mouse button, select Properties, Shortcut. 
5. Change the Target: from the name of the local drive to the name of the server 

drive, such as from C:\Program Files\Sag10w3\Sag10w3.EXE to 
R:\SAG10Net\Sag10w3.EXE if C is the local drive and R is the server drive. 

6. Change the Start In: from the name of the local drive to the name of the server 
drive, such as from C:\Program Files\Sag10w3 to R:\Sag10Net (or similar). 

7. Select OK to close the Properties form. 
8. Use Windows Explorer to delete the SAG10 files in the local drive, such as 

DELETE C:\Program Files\Sag10w3\*.*. 

1.4.7 Using SAG10 on a network 
Using SAG10 on a network is essentially the same as using SAG10 from a hard disk on 
an individual computer. On the network, you can make a data file available to other users 
and allow them to make changes to the file, or you can protect the file from changes. You 
can use the network server to store and exchange data files between users, and many 
people can use a printer attached to the network server. 

1.4.8 Printing over a Network 
For information on setting up printers, see your Windows documentation. The procedures 
for printing over a network generally are the same as printing procedures for an 
individual computer. You use the Windows Setup program to set up all printers available 
to you. Then you choose the Page Setup command on the Setup menu in SAG10 and 
choose the Printer Setup button to select a printer for use with SAG10 and to change the 
settings for the active printer. If you have installed more than one printer, when you start 
SAG10 for the first time, make sure you select the printer you will be using for your 
documents. If you select one printer when you format a document and a different printer 
when you print the document, some fonts, point sizes, and other character formatting 
options may not be available when you print. 

---------------------------------------------------------------------------------------------------------
NOTE 

Your network software may require you to issue a system command to 
make a network printer available to your computer. For specific procedures 
for your network, contact your network administrator. 

---------------------------------------------------------------------------------------------------------
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Special Note for BatesTM TLCADD users: 
For installation details and additional information, refer to Appendix C, “Notes for Bates 
Spotting Program” in the White Papers section at www.SAG10.com/documentation

1.5 Known Issues  
If you are a current user of SAG10, you are probably aware of several issues with the 
software. Southwire has endeavored to correct as many of these as possible. Currently, 
we are aware of the following issues: 

The “wind only” selection on the ADSS parameters entry screen has “ice only” choices. 
This was an error in the previous version of SAG10 and will be corrected in the next 
version. 

When you change the font from the Sag & Tension Data screen, the does not change. 
To see the change, you have to return and run the calculations again. 

Some of the project files saved in prior versions of ACA will not load. 
Southwire has attempted to maintain compatibility with prior saved project files, but prior 
versions of SAG10 did not always save the project information correctly.  In fact, 
sometimes they would not even load in the ACA versions.  You may be requested to re-
enter data that SAG10 does not recognize, or you may have to re-build your project in 
Southwire SAG10 to have the data store correctly. 

When I set my monitor to a high resolution, like 1920x1200, some of the screens look 
different. 
The software may look different based on your monitor resolution.  If you are having 
problems reading screens, please set your monitor to a lower resolution. 

What happened to Vibrec? 
The Vibrec vibration analysis software was kept by ACA so is not longer a feature in 
SAG10.  Please visit their website to obtain a free copy of the Vibrec software. 

For the most up-to-date information on issues and questions, please visit us on the web at 
www.SAG10.com.

1.6 Technical Support  
For SAG10 technical support, call 1-877-SWSAG10 (1-877-797-2410) or visit us on the 
web at www.SAG10.com/support.
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Getting Started with SAG10

Create a Project File 

Select the Conductor 

Enter the Ice/Wind Load and Tension Limits 

Enter the Ruling Span Lengths 

Calculate Sag and Tension 

Southwire Sag10 User’s Manual v3.10.6Southwire Sag10 User’s Manual v3.10.7



9  Southwire Sag10 User’s Manual v3.10 

2 Getting Started with SAG10  
There are five basic steps to creating a sag and tension report.
Each of these steps has multiple options, and each step may be affected by options you 
select for the entire project.  
• Create a project file (This is an optional step.)  
• Select the conductor for the project  
• Enter the ice/wind load and tension limits for the project 
• Enter the ruling span lengths  
• Calculate sag and tension

Within some steps, you can either use standard data from SAG10 tables, or you can edit 
and save custom data.  

2.1 Create a project file   
To begin using SAG10, click on the Southwire SAG10 icon. The SAG10 banner will 
display briefly, then the SAG10 Main Menu screen will appear.  
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• Enter the project title or number in the Title box. 
• Enter descriptive information in the Description box.
• You can edit this information at any time by simply right clicking in one of the text 

boxes, or highlighting text you wish to change. 

---------------------------------------------------------------------------------------------------------
NOTE 

The Tools Options menu in the SAG10 Main Menu screen toolbar offers 
many important project option choices. For Options details, refer to the Main 
Menu toolbar controls section.

---------------------------------------------------------------------------------------------------------

2.2 Select the conductor  
In the Conductor Selection panel of the Main Menu screen, click on the Select button. 
The Conductor Selection screen will open.  

Southwire Sag10 User’s Manual v3.10.6Southwire Sag10 User’s Manual v3.10.7



11  Southwire Sag10 User’s Manual v3.10 

Select a conductor construction from the Conductor Type panel.  For this example, 
choose ACSR. A list of available ACSR conductors will open under the Conductor or 
Messenger box. Select a conductor, and data for that conductor will automatically be 
loaded. Buttons in the Data and Conductor Options panels of the Conductor Selection
screen let you customize conductor construction data to suit your application. You can 
save custom conductor constructions to the SAG10 database or use and save them only 
with the current project (See below). Any conductor options you select will be saved with 
the project. 

When you have completed your conductor selection, and any conductor data edits you 
want, click on the Accept button in the Conductor Selection screen to return to the 
Main Menu.

Conductor selection screen details
For more details on conductor selection, refer to the chapter on the Conductor Selection
screen. 

2.3 Enter the ice/wind load and tension limits 
The Load Selection panel of the Main Menu contains a list of industry-standard load 
configurations. The Customary loads and tensions are the equivalent of the old 
REA/Alcoa loads and tensions. You can select a standard load table, create a custom load 
table, or open a saved load table. For the purposes of this example, select NESC
Medium.

To view or modify a load table, click on the Edit Load Table button in the Load
Selection panel. The Edit Load Table screen will appear, preloaded with any selection 
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you have made in the Load Selection panel of the Main Menu. In our example, this 
screen should open preloaded with the NESC Medium values since we previously 
selected NESC Medium from the Load Selection panel of the Main Menu.

For the purposes of this example, click on the Accept Loadings button to return to the 
Main Menu.

Load selection details
For more details on load selection, refer to the Edit Loading Table chapter. 

2.4 Enter the Ruling Span lengths  

You can enter up to 50 ruling spans in the Ruling Spans panel of the Main Menu.
• You can enter spans individually
• You can create a series of spans.  
• Accept each entry by pressing the Enter key. 
• Units are Feet or Meters, depending on option selected in the SAG10 Main Menu

toolbar→Tools→Options screen.

For our example, type in a value of 500 feet, and press the Enter key. 
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The buttons in the Ruling Spans panel of the Main Menu let you edit the ruling spans 
list. You can: 
• Insert Span will insert a span above the currently selected span.  
• Delete Span will delete the selected span.  
• Clear Spans will clear all of the spans in the table.  
• Series of Spans opens the Ruling Spans window to create a series of spans.
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To create a list of multiple ruling spans, equally spaced, simply enter a starting span 
length, the length you want to increment the spans by, and an ending span length. Click
on the Create button, and the table will be filled in. Click on the Accept button, and 
these values will appear in the Ruling Spans table on the Main Menu.

2.5 Calculate sag and tension  

---------------------------------------------------------------------------------------------------------
NOTE 

Before calculating sag and tension, be sure to: 
1. Select a conductor 
2. Specify load conditions 
3. Enter a ruling span or spans  

---------------------------------------------------------------------------------------------------------

You can initiate SAG10 sag and tension calculations in two ways:
• Click on the Calculate Sag & Tension button at the bottom of the SAG10 Main

Menu
• Select Main Menu toolbar→Run→Sag & Tension. 

Either way, SAG10 will generate a Sag & Tension Data screen that can be viewed, 
saved to a file, or printed. 

Sag and tension output details
For more details on sag and tension outputs, refer to the Sag & Tension Data Screen 
chapter. 

---------------------------------------------------------------------------------------------------------
NOTE 

The Tools→Options menu in the toolbar of the SAG10 Main Menu offers 
many important project option choices. For Options details, refer to the Main 
Menu chapter. 

---------------------------------------------------------------------------------------------------------
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Main Menu Toolbar Controls

File Menu 

Run Menu 

Tools-Options Menu 

Tools-Chart Explorer 

Set-up Menu 

Help Menu 
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3 Main Menu toolbar controls 
The Main Menu toolbar is located at the top of the SAG10 Main Menu.

3.1 File menu  

3.1.1 New 
Select New to clear all previous Project file data. 

3.1.2 Open 
Select Open to browse for an existing Project file and open it. Loading a file will clear all 
current Project file data.  

3.1.3 Save 
Select Save to save a newly created file, or to save an existing Project file. This selection 
is active only after you have selected a conductor, load parameters, and ruling span data. 
Save SAG10 project files with an .s10 extension.  

3.1.4 Save As  
Select Save As to save a Project file under a new name. This selection is active only after 
you have selected a conductor, load parameters, and ruling span data. Save SAG10 
project files with an .s10 extension. 

3.1.5 Exit  
Select Exit to close SAG10 and return to Windows. 

3.2 Run menu 

3.2.1 Sag & Tension 
The SAG10 Main Menu toolbar→Run→Sag & Tension selection executes the SAG10 
sag and tension calculations. Choose this selection only after selecting a conductor, load 
parameters, and ruling span, and any options in the SAG10 Main Menu toolbar 
Tools→Options screen.

Sag and tension output details
For more details on sag and tension outputs, refer to the Output Screen chapter. 

3.2.2 Pause between Spans 
If you select the Main Menu toolbar→Run→Pause between Spans option, or the Pause
between Spans box in the Ruling Spans panel of the Main Menu, a Next Span option 
will be displayed in the toolbar of the Sag & Tension Data screen. Selecting Next Span
will step through the sag and tension calculation for each ruling span entered.  
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If there is only one span to run, then this option does not affect the output.

If you have selected the Marker Balls or Use as a Messenger option in the Conductor
Selection screen, and Pause between Spans is not checked, there will be no query for 
changing quantities of marker balls or cables among spans.  

If you enter a large number of spans and a Warning Message is received during 
calculation that indicates Out of Memory or Output Exceeds Buffer Size, then you may 
have to either: 
• Use the Pause between Spans option, or
• Reduce the number of ruling spans.  
If these messages are displayed, the screen output will be incomplete, but the Print to 
File output will not be affected. 

3.2.3 Inclined Spans 
If you select the Main Menu toolbar→Run→Inclined Spans option, the Inclined Span
screen will open.  
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Stringing sags generated by the graphic-method are for level ground spans and are based 
on the average tension (Pav) of the conductor. There are times when the combination of a 
long span and difference in elevation creates difficulties in sagging conductor.  

Depending on the span length and difference in elevation, the lowest point of sag may fall 
beyond the lower support (indicated by a negative value for the x-coordinate in the 
Lowest Point box) or the vertical tension at the lower tower may become positive. If 
either of these conditions occurs, this indicates that there may be an up-lift problem at the 
lower support attachment point. To correct this, enter a lower value for the Horizontal 
Tension.

Sag calculation temperature  
The SAG10 inclined span option calculates the proper inclined Span length (SL) and 
average tension (Pav) to be used based on the Horizontal Tension input. Therefore, as 
tension varies with temperature, the sags and clearances resulting from the inclined span 
calculations are only valid at the temperature associated with the Horizontal Tension
input. For example, if the horizontal tension is an initial tension at 60°F, the resulting sag 
and clearance values are valid only for the 60°F initial condition.

Inclined Span control buttons
• Calculate will re-calculate the inclined catenary after changing any data. 
• DXF will save the inclined catenary as a .DXF file to a location you specify. A DXF 

file can be imported into most CAD programs. Typical uses would be to generate a 
sag template, or to import the sag curve into a drawing containing some ground 
profile for structure spotting. 

• Print will send the inclined span results to the printer. 
• Close will close the Inclined Span screen and return you to the Main Menu screen.

3.2.4 Ruling Span Calculation  
If you select the Main Menu toolbar→Run→Ruling Span Calculation option, the 
Calculate Ruling Span screen will open. This SAG10 utility calculates a ruling span 
from a list of spans. 
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Enter a list of spans within a ruling span into the table and click on the Calculate button.
The resulting ruling span calculation shows in the box below the Calculate button.  

Calculate Ruling Spans control buttons 
• Append will append the calculated ruling span to the bottom of the ruling span list in 

the Ruling Spans panel of the Main Menu screen.
• Replace will remove any existing ruling spans from the ruling span list in the Ruling

Spans panel of the Main Menu screen and replace them with the calculated ruling 
span.

• Save Span File saves the span file to a location you specify as a .SPN file type.
• Open Span File retrieves an existing span file.  

Saved span lists can also be recalled and used when creating stringing sag tables. For 
more information, refer to the Stringing Module section in the Output Screen Chapter.
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3.3 Tools – Options menu 
You can adjust key project option settings by selecting Main Menu
toolbar→Tools→Options. The Option Settings screen will open.

Options you set are saved as part of the current project file. When you are finished 
selecting options, you can:
• Click on the Save button, and the selected options will become the defaults when you 

load the program, or  
• Click on the Accept button, which saves your selections for the current session only.  
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3.3.1 Elevated Temperature 
The Elevated Temperature options are provided for you to include various affects due 
to operation of conductors at elevated temperatures. These options should not be used for 
ACSS conductors, which are designed for high operating temperatures. 

Input
This option will cause SAG10 to include the effects of increased creep due to operating a 
conductor at elevated temperatures. The default selection for this option is unchecked. 
When you check the Input box, the Elevated Temperature Creep screen opens. When 
working with elevated temperature calculations, SAG10 will modify the Load Table 
before calculating sag and tension. For each temperature in the Elevated Creep Table at 
or above 16°C (60°F), SAG10 will create an additional row in the Load Table and assign 
that row a code value of 3 to designate the row as an Elevated Temperature Point.  
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Enter the total time for which the conductor is expected to experience elevated 
temperatures over the life of the line. Entries are in hours and °C. 

If the conductor selected is all-aluminum (AAC, AAAC, ACAR) or an ACSR with 
strands of 84/19, 84/7, 45/7, 20/7, 18/1, 42/7, 76/19, 72/7, or 36/1 (ACSRs with less than 
7.5% steel by area), the values entered into the Elevated Temperature Creep table will 
be used in the elevated temperature calculations.  

Elevated temperature creep of ACSRs with more than 7.5% steel by area is less than 
room temperature creep and can be ignored. If you have chosen an ACSR with more than 
7.5% steel, the program will issue a warning message, uncheck the Elevated 
Temperature Input box, and bypass the Elevated Temperature Creep table.  

Finally, click on either the Rolled or Cast Rod option, whichever is appropriate for the 
conductor being modeled. 
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---------------------------------------------------------------------------------------------------------
NOTE 

Elevated temperature creep for non-standard loading temperatures 

If you are entering a non-standard loading, you must enter the Elevated 
Temperatures manually, as follows:

• Click on the Edit Load Table button in the Load Selection panel of 
the Main Menu screen. 

• Each of the temperatures in the Elevated Temperature Creep table at 
or above 16°C (60°F) should be entered in TWO rows in the Load 
Table.

• The first row should have NO Code entry.
• The second row should have a Code value of 3.

For example, if the Elevated Temperature Creep table has a temperature of 
125°C entered, then the Load Table should have two rows with a 
temperature of 257°F, one with NO Code entry and one with a Code value 
of 3. This shows up in the sag and tension output as a comparison of sag at 
257°F with and without elevated temperature creep. In the Sag & Tension 
Data screen, the elevated temperature creep line is identified by a # sign. 

Temperatures less than 16°C in the Elevated Creep Table will be ignored, 
as they are not affected by elevated temperature.

---------------------------------------------------------------------------------------------------------

Output Strain
This option is considered only if the Elevated Temperature Input box is checked. If 
that box is checked, the sag and tension output will include a line of data at the first 
elevated temp creep point, indicating normal creep (EC) and elevated temperature creep 
(ECRP).

Creep is a function of time and temperature. SAG10 will select the time/temperature that 
will cause the maximum micro-strain increase in elongation and convert it to a 
temperature differential. 

For more background on elevated temperature creep, research the following papers: 
• J. R. Harvey, R. E. Larson - Use of Elevated Temperature Creep Data in Sag-Tension 

Calculations, IEEE Paper 69 TP 674-PWR. 
• J. R. Harvey, R. E. Larson - Creep Equations of Conductors for Sag-Tension 

Calculations, IEEE Paper C 72 190-2. 
• J. R. Harvey, R. E. Larson - Technique to Include Elevated Temperature Creep in 

Sag-tension Calculations, IEEE T and D Conference and Exposition April 1-9, 1979. 
• W. B. Zollars - Aluminum Conductor Elevated Temperature Considerations, Seminar 

sponsored by Georgia Power Co., the Aluminum Association, and EPRI on the 
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Effects of Elevated Temperature Operation on Overhead Conductors and Accessories 
- May 20, 1986, Atlanta Georgia. 

Aluminum Compression 
ACSR conductors are composed of two materials, steel and 1350-H19 hardened 
aluminum. These materials expand at different rates when heated. The coefficient of 
linear thermal expansion for aluminum is approximately twice that of steel, so as an 
ACSR conductor is heated, the aluminum will attempt to expand more than the steel core. 
Since the aluminum and steel are connected together at various points along the line, the 
steel prevents the aluminum from elongating as much as it wants to. Under these 
conditions, the helical path of the aluminum grows and a compressive force builds in the 
aluminum, similar to a compressed spring. 

This is not a problem in the normal operating temperature range of ACSR, which is 
below 100°C. However, at elevated operating temperatures, the amount of growth in the 
aluminum is much more than the growth in the steel. Since they are connected together, 
the aluminum “spring” pushes against the steel core as it grows. This extra force on the 
steel is not part of the normal sag and tension calculations. It causes the steel to elongate 
more, and thus the conductor to sag more, than the standard calculations predict. 
Selecting the Aluminum Compression option will cause SAG10 to take into 
consideration the additional expansive force imparted to the steel by the aluminum. 

Note: This only applies to ACSR conductors. This is not an issue in ACSS conductors 
due to the use of fully annealed 1350-O aluminum, which yields more readily than 
hardened 1350-H19 aluminum. For this reason, compressive forces do not build in the 
aluminum to a level high enough to affect the steel core. 

For details, refer to Appendix V, “Theory of Compressive Stress in Aluminum of ACSR” 
and Appendix Y, “Some Effects of Mill Practice on the Stress Strain Behavior of ACSR”, 
in the White Papers section on the web at www.SAG10.com/documentation.

3.3.2 Input and Output tensions  
A tension value may mean several things. It can describe horizontal tensions, vertical 
tensions (tension magnitude at support points) or average tensions (an in-between value 
representing the tension state of the entire span).  
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When you fill in the Load Table, you may require a limit based on a particular tension 
type. Conversely, in the sag and tension data output, you may want to display a different 
type of tension. SAG10 lets you specify input and output tension types separately in the 
Input Tensions and Output Tensions panels of the Options Settings window. In addition, 
the Output Tensions panel has a box that lets you select a display that separates the 
tension components attributed to steel and aluminum. (See below for details.)  

Average tension 
The default used for tension is the average value. This is the tension in the conductor.  

Horizontal tension (at sag)  
The horizontal tension (at sag) subtracts out the weight of the wire. Horizontal tension is 
used in offset clipping and inclined span options. Formulas used for leveled spans are as 
follows: 

 H = P - WD/2 

Where: H = Horizontal tension at center of span, lb. 
 P = Average tension, lb. 
 W = Conductor weight, lb./ft. 
 D = Sag, ft. 

Vertical tension (at supports)  
The vertical tension (at supports) includes the weight of wire. The tension at the supports 
is used in tower-design calculations. Formulas used for leveled spans are as follows: 

 T = P + WD/2 

Where T = Tension at support, Lbs. 
 P = Average tension, Lbs. 
 W = Conductor weight, Lbs./ft. 
 D = Sag, ft. 

Separate Aluminum and Steel Tension
The basis for the Alcoa Graphic-Method of sag and tension is stress-strain testing. When 
stress-strain tests are performed on steel core conductors, both composite (aluminum 
combined with steel) and single (that of the steel only) data are generated. When dealing 
with steel core conductors, the Graphic Method derives the stress-strain data of the 
aluminum portion by subtracting the available steel data from that of the composite.  

At each temperature specified in the Load Table, the calculations are performed using 
the data from the components, which are then added vectorially to form the composite. 
The Separate Aluminum and Steel Tensions option will cause the tensions in each of 
the components to be displayed, as well as the total tension in the conductor. The ability 
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to view the separate tensions can be a valuable tool when evaluating operation of ACSRs 
at high temperatures, or when calculation pre-tensioning for ACSS conductors.  

3.3.3 Other (Estimated Cast Rod Creep) 

Rolled verses Cast Rod 
Cast rod generates less overall creep than rolled rod. In order to switch the calculations to 
Cast Rod, check the Cast Rod option.

Adjust Expan for ACSR/AW  
SAG10 uses stress-strain charts for standard Galvanized steel core for calculations 
involving ACSRs with aluminum-clad steel core wire. Aluminum-clad steel actually has 
a slightly higher coefficient of linear thermal expansion due to its aluminum coating. 
Selecting this option will cause the calculations to use the appropriate thermal expansion 
rate. 

---------------------------------------------------------------------------------------------------------
NOTE 

This box will be active only if you have selected an ACSR conductor with an 
AW option. 

---------------------------------------------------------------------------------------------------------

3.3.4 Optional Columns in Output  
These option boxes add columns to the sag and tension output for final and initial tension.  
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• None – no added columns 
• % RBS – Percentage of Rated Breaking Strength
• H/W – Horizontal Tension divided by Weight. This is often referred to as the 

“Catenary Constant” or “C” value
• Horizontal and Vertical Sag – displays the resultant sag as horizontal and vertical 

components.

3.3.5 Units  
There are four options available for Units:  

• English - Both Input and Output are in Pounds, Feet or Inches, and Deg. Fahrenheit. 
• English-to-Kg - English Input and Metric Output in Kilograms, Meters or 

Millimeters, and Deg. Centigrade. 
• Kilogram - Both Input and Output are in Kilograms, Meters or Millimeters, and Deg. 

Centigrade. 
• Newton - Both Input and Output are in Newtons, Meters or Millimeters, and Deg. 

Centigrade. 

3.3.6 NESC K 
 Occasionally it is necessary to distinguish between NESC 5th or 6th Edition and the 
rounded-off K factor of the NESC 7th Edition.  

New – Designates NESC 7th edition 
Old – Designates NESC 5th or 6th edition
Old (Steel and Cu) – Match calculations for steel or copper cable for the older NESC 
manuals  
Zero - Ignore K
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3.3.7 Creep (time selection)  
SAG10 normally calculates final sag and tension data assuming 10 years of conductor 
creep. 

Entering a number in Creep Time at Stress (Days) lets you calculate the final creep that 
would result from a longer or shorter time period. A shorter time period may be helpful in 
evaluating conductors that have been in air for any time period less than 10 years. A 
longer time period may be helpful to see if any additional creep may occur if a conductor 
has been in the air for 20 or 30 years. Enter the time period in days. Blank or 0 will 
default to 10 years.  

3.3.8 Also Output Results to 

Default Printer 
Automatically sends the results shown in the sag and tension calculation output screen to 
the default printer specified in the Print Setup section of this manual.  

File 
Automatically sends the results shown in the sag and tension calculation output screen to 
a specified file. SAG10 will prompt you for a file name to save the output when you run 
the sag and tension calculation. 

3.3.9 Folder Path setups 

Conductor Data
Browse or specify a path to a default folder containing conductor data.

Project Files 
Browse or specify a path to a default folder containing Project File data.
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3.3.10 Stress-Strain Curves 
Typically SAG10 uses the full stress strain curves. These return the stress level at ANY 
strain value as calculated using the polynomial coefficients from the stress-strain charts.  
The default for this option is Use Full Curves and Southwire recommends that you do 
not change this.  The Threshold Strain is now set to 0.5%. 

There are times, especially when large mechanical loadings are placed on a conductor, 
particularly in longer spans, that very large strains are encountered. SAG10 may have to 
estimate, to the best of its ability, the stress-strain curve in these situations to complete 
the calculation. However, the user should be aware that this is occurring as it may affect 
the accuracy of the results.  If this occurs, a message will display on your output 
indicating that SAG10 used an extrapolated curve. 

3.3.11 Send To File 

Overwrite 
When you check this box, the data sent to a specified file will overwrite the existing data.  

Append to Existing File 
When you check this box, the data sent to a specified file will be appended to the existing 
data.

3.4 Tools – Chart Explorer 
Selecting Main Menu toolbar→Tools→Chart Explorer will open the Chart Explorer
screen. This screen shows a list of conductor detail charts, sorted by chart number. 
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The chart explorer lets you quickly view any charts available in SAG10, including those 
you create.  Charts that are Locked cannot be edited. 

Add 
The Add button allows you to create a custom chart.  Clicking on this button will open a 
blank Chart Details screen for you to fill in. 

Delete
This will delete the currently selected chart from the database. 

Details 
This will open the Chart Details screen for the selected chart. 

Save
This will save any charts you have created or edited to the database.
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If you select a chart in the Chart Explorer screen and click on the Details button, a 
Chart Details window will open.  

The Paste and Copy buttons allow you to move data to and from a Microsoft Excel 
spreadsheet. 

3.5 Setup menu 

3.5.1 Print setup 
Selecting Main Menu toolbar→Setup→Print Setup displays the standard MS Windows 
printer setup and selection window. Refer to the MS Windows User's Guide for details on 
use of Print Setup. 
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3.5.2 Page setup 
Selecting Main Menu toolbar→ Setup→Page Setup opens the SAG10 Page Setup
screen where you can set page header options. 

First Page 
These header options will appear on the first page of output only. 
• The Date is checked by default. Uncheck it if you do not wish the date to appear on 

the output. 
• Company Name is a new feature that allows you have you company name appear on 

the outputs. Check the Company Name checkbox and enter your company name in 
the text box.  

Second Page 
These header options will appear on any subsequent pages of output. 
• Checking Title will cause the text entered in the Title field of the Main Menu to 

appear on subsequent pages. Note that the Title and Description entered on the Main 
Menu always appear on the first page.

• Checking Conductor Data will cause the description for the conductor to appear on 
all subsequent pages.

• The Date is checked by default. Uncheck it if you do not wish the date to appear on 
the subsequent pages.

• Company Name can only be selected if it is selected in the First Page header 
options. 
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3.5.3 Fonts 
Selecting Main Menu toolbar→ Setup→Fonts opens the SAG10 Font window. Only 
Fixed Pitch Fonts may be selected. SAG10 requires that the Courier New font be loaded 
into Windows. If the proper fonts are not currently installed on your computer, refer to 
the Windows Control Panel, Fonts for information on loading addition fonts. 

3.6 Help menu 
Selecting Main Menu toolbar→Help in the SAG10 Main Menu tool bar will open a 
submenu with these options:  
• Contents  
• Search for Help On … 
• Tech Support 
• View License 
• About SAG10 

All of the material in this manual is available in SAG10 Help.
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3.6.1 Help→Contents→function tabs

Contents
This tab gives access to a list of SAG10 User Manual topics organized in Table of 
Contents order.  

Index
This tab gives access to the standard Microsoft index feature. 

Find
This tab gives access to the standard Microsoft word or phase search feature.  

3.6.2 Help →Search for Help On …  
This tab gives you direct access to the standard Microsoft index feature. 

3.6.3 Help →Tech Support 
This menu item displays contact information for Southwire SAG10 technical support.   
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3.6.4 Help →View License 
This menu item displays selected licensing information and other information about 
Southwire SAG10.  

3.6.5 Help →About SAG10 
This menu item displays the version number and registration number of the current 
SAG10 program installation.  
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Conductor Selection Screen

Conductor Type 

Conductor Messenger Box 

Data Panel 

Conductor Options 

Sort  Options 

Southwire Sag10 User’s Manual v3.10.6Southwire Sag10 User’s Manual v3.10.7



 01.3v launaM s’resU 01gaS eriwhtuoS  73

4 Conductor Selection Screen  
To access the Conductor Selection screen, click the Select button in the Conductor
Selection panel of the SAG10 Main Menu screen.

The Conductor Selection screen has five main components: 
• The Conductor Type panel, where you choose the type of conductor to use. 
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• The Conductor or Messenger box, where a drop down menu lets you select a 
specific conductor or support messenger.  

• The Data panel, which shows a data summary for the specific conductor you have 
chosen.

• The Conductor Options panel, where you can select options for the specific 
conductor you have chosen. Not all options are available for some conductor 
types. 

• The menu toolbar which allows you to change the sort options for the dropdown 
list for the Conductor or Messenger box. 

In addition to these five main panels, other panels may appear with additional 
information for a specific conductor type. For example, ACSS conductors are available in 
three different strength options. When you choose an ACSS conductor, a Strength
Options panel appears, with the available strength options. When you click on a strength 
option, the RBS value in the Data panel automatically updates.  

4.1 Conductor Type  
This panel lets you select a construction type. When you choose a general construction 
type, a dropdown menu will open below the Conductor or Messenger box and display 
specific conductors. Southwire has updated the conductor tables to match current ASTM 
standards, where standards exist.

Some data has been provided by other manufacturers, or is based on historically accepted 
industry values. Data for these conductors is provided as-is, and should be verified as 
accurate for your particular conductor. 
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---------------------------------------------------------------------------------------------------------
Note

Standards and manufacturing methods have changed over the years and 
older conductor designs may not exactly match the values in use today. 

---------------------------------------------------------------------------------------------------------

Custom conductor types
Any custom conductor types you build and save are stored in a central file that you can 
access by selecting the Custom type in the Conductor Selection panel. For details on 
creating custom conductors, refer to the Editing Conductor Data section, below.  

4.2 Conductor or Messenger Box 
This is where you select the specific conductor to use, either as a conductor or as a 
support messenger for an assembly. The dropdown list automatically opens when a 
Conductor Type is selected, or you can open the dropdown at any time by clicking on 
the dropdown arrow on the right side of the box. 

4.3 Data Panel 
Once you select a specific conductor, the data for that conductor will automatically load 
into the conductor Data panel.  

If this is the conductor you want, choose any conductor options you need, then simply 
click the Accept button at the bottom of the Conductor Selection screen to return to the 
Main Menu screen. There are two other buttons in the Data panel that allow you to view 
the stress-strain chart associated with the conductor or edit the conductor data and create 
a custom conductor. 
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4.3.1 View Chart 
The View Chart button in the Data panel will take you to the Chart Details screen and 
show you the stress-strain data assigned to the selected conductor. A unique chart number 
identifies each chart.  

4.3.2 Editing conductor data  
The Edit Data button in the Data panel opens the Edit Conductor Info screen, shown 
below, where you can create a custom conductor by modifying the name and 
characteristics of the conductor you’re working with. Note that the contents of this screen 
will change based on the conductor type selected.  

You can create a custom conductor by editing the conductor data, then saving this to the 
custom conductor file.  

• The Accept button will close the screen and retain the modified values for this 
Project File only – it will not save them to the conductor database.  

• To save your modified values to the Custom type in the conductor database, 
assign a new conductor name and click on the Save to Custom button.  

• The Delete Custom button lets you remove unnecessary custom files from the 
Custom type in the conductor database.  

• The Chart Explorer button takes you to the Chart Explorer screen. Here you 
can review available charts or create a new stress-strain chart if needed. For 
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more details, refer to the Tools→Chart Explorer panel of the Main Menu 
chapter.  

4.4 Conductor options 
The Conductor Options box lets you add special features to your 
conductor selection:  
• TP (Twisted-Pair) 
• Use as a Messenger 
• Marker balls 
• PLP spoilers.

Conductor options that are not available for the selected Conductor
Type will appear in gray, as is the TP (Twisted Pair) option in the 
example above.  

4.4.1 TP (Twisted Pair) option 
Any of the ACSR, AAC, AAAC, or ACAR conductors may be modeled as a twisted-pair 
conductor. You may be more familiar with this construction by one if its trade names, 
such as VRTM by Southwire, or T-2TM by General Cable. If you select the TP (Twisted 
Pair) option, the conductor description will indicate use of TP by appending the “/TP” 
suffix to the codeword. 

The weight, strength, and area of the wire are doubled, and the diameter is considered to 
be 1.637 times larger than the single conductor for wind and ice calculations. When this 
option is selected, a TP Equivalent Values panel appears with the resulting data used by 
SAG10.
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4.4.2 Use as a Messenger 
This option allows you to add several non-supporting cables to a supporting conductor or 
messenger. Each of the non-supporting cables must be of equal diameter and weight. 

In the Additional Weight entry, you can add the weight of additional items, such as 
hangers, as an evenly distributed weight. Enter it in lb/ft (kg/m or N/m for metric). Do 
this by manually summing the total weight of additional attachments, and dividing by the 
total span length. 

Hanger Ice Load Factor is a factor added to account for ice buildup on the hangers. 
Determination of the amount of ice is left to the design engineer. The number that has 
traditionally been used, based on 0.5 inches of ice buildup on the hanger, is a value of 
1.8. Southwire does not endorse or recommend this number. For other ice buildup 
thicknesses, enter your calculated value. 

SAG10 multiplies the weight of a cable by the quantity of cables and adds that to the total 
weight. This total weight is evenly distributed over the span length. Radial ice is applied 
as a uniform layer over each of the cables, as well as the supporting messenger. Wind 
pressure is applied over the cross sectional area of the cables and messenger. Radial ice 
will increase all cable and messenger diameters, and resulting wind areas, by twice the 
radial ice thickness.  

Apply the NESC K Factor 
The NESC K factor can be applied in two ways: Only to Messenger or to Each Cable 
and Messenger. The NESC manual does not clearly define whether the K factor should 
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be applied to the messenger only, or to each of the cables and the messenger, so both 
options have been offered to allow for the users discretion.  

Design Limits Apply
The design limits for messenger-supported assemblies can be applied Before
Attachment or After Attachment. If you want SAG10 to apply the design limits to the 
complete assembly, click on the After Attachment button. This will ensure that the 
design conditions are met, after installation of cables and additional weights. 

You may also design messenger-supported systems by applying the design limits to the 
messenger only. If you want SAG10 to apply the design limits to the messenger only, 
click on the Before Attachment button. The sag and tension output will then display two 
calculations per span, the first with the design limits applied to the messenger only, the 
second to showing the effect on the total assembly.  

---------------------------------------------------------------------------------------------------------
WARNING!

When you select the Before Attachment option, pay special attention to the 
two calculations per span. It is possible for the first, where the limits are 
applied to the messenger only, to meet all of the design limits, and the 
second, showing the effect on the total assembly, to exceed the bare wire 
design limits. This method should only be used with qualified engineering 
supervision.

---------------------------------------------------------------------------------------------------------

The Supported Cable Information options do NOT apply to the following designs:  
• Any non-supporting cable in direct contact with the messenger, such as figure-8 cable 

or lashed cable. 
• Any pre-assembled non-supporting cable that is strung at the same time as the 

messenger, such as figure-8 cable. 
Calculations for these situations are explained below. 

4.4.3 Non-supporting cable, pre-assembled or lashed 
Use this calculation method for non-supporting cables pre-assembled to a messenger 
prior to stringing. 

1. Determine basic information for the messenger, such as area, diameter, weight 
(per foot, or unit of measure), RTS and chart number.  

2. Determine the diameter and weight (per foot, or unit of measure) of the cable(s) 
being supported. 

3. In the Conductor Selection screen, select a Conductor Type for the messenger, 
then a specific conductor to be used as the messenger. 

4. Click Edit Data in the Data panel and enter the Area of the messenger. Enter the 
Weight (per foot, or unit of measure) of the messenger plus cables. For the 
Diameter, enter the assembly diameter exposed to the wind. Enter the RTS of the 
messenger cable and Chart number for the messenger. 

5. You can now use this selection for your sag and tension calculations. 
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If the cables are in direct contact, such as with lashed cable, the actual amount of 
combined ice build-up will vary depending on the configuration, quantities and diameter 
of the attached cable(s). As a result, all calculations assume the most conservative 
situation: that each cable will be covered with a uniform layer of the radial ice specified 
in the loadings table. If this is too conservative, it is up to the user to calculate an 
appropriate reduction of ice, and then reduce the radial ice indicated in the loadings table 
accordingly. 

4.4.4 Marker Balls  
This option allows you to add marker balls to a conductor. Each of the marker balls must 
be of equal diameter and weight. 

SAG10 multiplies the Weight of Ball by the quantity of balls and adds that to the total 
weight. This total weight is evenly distributed over the span length. Radial ice is applied 
as a uniform layer over the balls, as well as over the conductor. Wind pressure is applied 
over the cross sectional area of the balls and conductor. Radial ice will increase all 
diameters, and resulting wind areas, by twice the radial ice thickness.  

If marker balls are placed on all the spans within a ruling span, and their weight is evenly 
distributed among all spans, then the results may be obtained using this method. Fill in 
the Data Input for Attachment of Marker Balls prompt screen, using the ruling span 
length, total quantity of marker balls, their individual diameter and weight, and any 
additional weight you may have.  
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If the marker balls are on a single span within the ruling span, meaning the span is not 
dead-ended on either side, then additional calculations must be performed to determine 
the sag and tension information within that span. For details, refer to appendices G11A 
and G11B in the White Papers section at www.SAG10.com/documentation.

When you have selected the Marker Ball option, the marker ball data appears in the 
middle of the sag and tension run, serving as a break between the sag and tension data 
before and after the balls are installed. The second line indicates the quantity of balls, 
span, diameter and weight of one ball, and the additional weight (such as total weight of 
the vibration dampers) as the last item.  

Design Limits Apply 
The design limits for marker balls can be applied Before Attachment or After
Attachment. If you want SAG10 to apply the design limits to the complete assembly, 
click on the After Attachment button. This will ensure that the design conditions are 
met, after installation of marker balls and additional weights. 

You may also design systems by applying the design limits to the messenger only. If you 
want SAG10 to apply the design limits to the messenger only, click on the Before
Attachment button. The sag and tension output will then display two calculations per 
span, the first with the design limits applied to the messenger only, the second to showing 
the effect on the total assembly.  

---------------------------------------------------------------------------------------------------------
WARNING!

When you select the Before Attachment option, pay special attention to the 
two calculations per span. It is possible for the first, where the limits are 
applied to the messenger only, to meet all of the design limits, and the 
second, showing the effect on the total assembly, to exceed the bare wire 
design limits. This method should only be used with qualified engineering 
supervision.

---------------------------------------------------------------------------------------------------------

Stringing Sag Table Output for Marker Balls 
If you are running a Stringing Sag Table for a line with marker balls, SAG10 will 
generate output with the Initial data prior to adding balls, Final data with balls attached, 
and Final loaded data with balls attached. For more information, refer the Stringing
Module entry in the section on Output Screen toolbar controls.

4.4.5 PLP Spoiler  
Click on the PLP Spoiler button in the Conductor Options panel if you want the SAG10 
calculations to account for the horizontal and vertical loading created by PLP Spoilers. 
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Fill in the requested data, then click on 
the Accept button at the bottom of the 
Conductor Selection screen to return to 
the Main Menu screen. When you run 
sag and tension calculations, the output 
will show the added spoilers and the 
conductor weight for each load condition 
will include the additional loads created 
by the spoilers. 

4.4.6 ADSS Cable 
The SAG10 Conductor Selection panel of the Main Menu includes a selection for ADSS
(All Dielectric Self Supporting) cable. This feature was written specifically for cable 
manufactured by Alcoa Fujikura Ltd. (AFL). As such, it requires data that is not typically 
supplied by other cable manufacturers. There are no standard conductor designs available 
for this conductor type. Contact your ADSS cable manufacturer to obtain the information 
you need for this feature.  

In order to perform ADSS calculations, 
first choose ADSS from the Conductor
Type panel. The Data panel will load with 
no values, so click on the Edit Data button 
and type in the proper values requested on 
the screen. These values may be obtained 
from your ADSS cable manufacturer for 
your particular cable. Currently, the ability 
to store custom ADSS cable designs is not 
available. 

The MRCL stands for Maximum Rated 
Conductor Limit and RBS stands for Rated 
Breaking Strength, which is the same as 
Rated Tensile Strength. It is important that 
both MRCL and RBS values be accurate 
in order to allow stringing the cable to the 
proper design tensions.

SAG10 obtains the allowed percentage of 
RBS by dividing the MRCL by the RBS. 
This percentage is often 50%, but may 
range from 45% to 63+%, depending on 
the particular cable. The allowable 
percentage is increasing as new designs are 
developed.  
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4.4.7 OPGW cable 
The SAG10 Conductor Selection list includes the OPGW (Optical Ground Wire) type. 
The standard OPGW constructions listed are provided, as is, courtesy of Alcoa Fujikura 
Ltd. (AFL). For information and values for OPGW, contact your OPGW manufacturer. 

4.4.8 AAAC conductor 
The SAG10 Conductor Selection list includes the AAAC (All-Aluminum Alloy 
Conductor) type. The standard conductor tables supplied with SAG10 are for AAAC 
made from 6201-T81 aluminum alloy. There are other alloy types that have been, and are 
currently, being used, most notably 5005 alloy. However, 6201-T81 is the only aluminum 
alloy recognized by ASTM for AAAC at this time. 

4.4.10 ACSR/TW Codewords 

4.4.9  3M ACCR conductor  

Previous versions of the software identify diameter equivalent trap-wire constructions 
using a TWD suffix rather than the correct codeword.  The codewords for the diameter 
equivalent ACSR/TW conductors have been updated to the new Aluminum Association 
codewords, where they exist. For conductors that have not been assigned codewords, 
the codewords have been renamed to a generic name of "-----". 

4.5 Sort Options 
Once a conductor type has been selected, you can change the sort order for the selections 
in the Conductor or Messenger box dropdown menu from the Sort menu selection on 
the screen toolbar. 

• By Size will cause SAG10 to arrange the conductor choices by size, from smallest 
to largest. 

• By Codeword will cause SAG10 to arrange the conductor choices alphabetically 
based on the codeword, or the concatenated description for products without 
codewords. 

Aluminum Conductor Composite Reinforced (ACCR) is a high temperature low sag conductor 
available from 3M Corporation (www.3m.com/accr). ACCR is comprised of a stranded alumi-
num based composite wire core, which exhibits strength and stiffness comparable to a tradi-
tional ACSR steel core, but has about half the weight, and about half the thermal expansion 
coefficient of steel. The outer wires of ACCR made from a hardened aluminum zirconium 
alloy, which has properties similar to the 1350 H19 Aluminum wires used in ACSR. However, 
the zirconium alloying of these wires prevents annealing of the wires at high temperature. The 
combination of these materials results in ACCR having strength and stiffness similar to ACSR, 
but with less sag due to lighter weight and lower thermal expansion. ACCR conductors can be 
operated at up to 410 F (210 C) continuously, or 464 F (240 C) for 1000 hours over the life of 
the conductor. 

3M has conducted extensive high temperature testing of ACCR and associated accessories. If 
you choose to consider aluminum compression in your high temperature sag and tension 
analysis, then the default value of 2500 psi gives results consistent with high temperature tests.
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Edit Loading Table Screen

Load Table Fields 

Load Selections 

Gallop Load 

Creep Load 

Printing the Load Tables 
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5 Edit Loading Table Screen 
In the Load Selection panel of the Main Menu screen, you can choose from a list of 
industry-standard loading configurations. The Customary loadings and tensions are the 
equivalent of the old Alcoa or REA loadings and tensions. The user should always check 
these values to be sure they are still valid, as standards can change. 

If you are using the standard table values, all you have to do is click on a selection in the 
Load Selection panel on the Main Menu screen. However, if you would like to view or 
modify the Load Table, click on the Edit Load Table button in the Load Selection panel. 
The Edit Loading Table screen will appear, and if you have selected one of the standard 
loading, will pre-load those values into the loading table. If you have selected Create
Load Table on the Main Menu screen, a blank table with one row, 60°F and Code of 2, 
for creep check will pre-load. Table units and headings are based on your selection of 
Units in the Main Menu→Tools→Options screen. 

The figure above shows a load table with NESC Medium values selected. You can make 
additional entries up to a total of 50. 

You can create custom loading tables with the Save As button. Once created, Custom 
load files can be selected on the Main Menu screen by checking the Use Existing Load 
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Table box. This lets you create a standard load table with the temperatures you need and 
select it, without having to return to this screen each time you want to use those 
temperatures. 

5.1 Load Table fields  
The Load Table fields (columns) are:  
• Conductor Temperature (°F or °C) 
• Radial thickness of ice (in or mm). The default ice density is 57.3 lb/ft3 for glazed 

ice, per the NESC. Entering a negative value will cause SAG10 to use the ice density 
for Rime ice (or wet Snow). The default density for Rime Ice is 37 lb/ft3, but can be 
modified by clicking on the Change Rime Ice Density button. The value for Rime 
Ice resets to 37 lb/ft3 whenever the program is closed and started again. 

• Horizontal wind load (Psf, Kg/M2, or N/M2). Negative wind values are used as total 
wind weight per unit length. Negative wind values cannot be used when the Marker
Balls or Use as a Messenger options are selected on the Conductor Selection
screen. 

• Tension limit (Lb, Kg, or N, Ft, or a decimal fraction of RTS). If a negative value is 
entered, SAG10 will use the number as a sag limit. 

• Code values indicate when a condition or limit is to be applied. Options are:
1 = Initial Tension (Sag) limit 
2 = Final Tension (Sag) limit 
3 = Elevated Temperature Point  

---------------------------------------------------------------------------------------------------------
NOTE 

The bare weights in the outputs are from the conductor database or a custom 
conductor you create. Loaded weights are calculated by adding the bare 
weight plus the effect of the wind and ice as defined in the load table. 

---------------------------------------------------------------------------------------------------------

5.2 Load Selections 
You can quickly load a standard table using the loadings listed in the Load Selection
panel. Selecting from this list will cause any values currently in the load table to be 
deleted, and the new values loaded.

5.2.1 NESC 
The NESC (National Electric Safety Code) Heavy, Medium, and Light Loadings for 
Overhead Conductors are shown in the tables below. Tension limits shown are % RTS.
These limits indicate the maximum tensions allowed by the NESC. The user should 
verify these values, as they may change as the NESC code is revised.

The user should be familiar with the NESC standard, as there are exceptions and cases 
where it may be inappropriate to apply these limits. It is left to the user to determine if 
these values are appropriate and sufficient for the conductor selected and the operating 
conditions. For example, these limits and loads may need to be modified for all-
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aluminum conductors to prevent vibration, or loading conditions may be modified for 
operating conditions such as extreme ice and wind loads.

Note that AFL recommends that NESC Limits be reduced to 0.50 (50%) for ADSS 
cables. 

5.2.2 Customary 
The Customary Heavy, Medium, and Light Loadings for Overhead Conductors are 
shown in the tables below. Tension limits shown are % RTS. These tables have been 
previously known as Alcoa or REA limits. They are more conservative than the NESC 
limits. If the user is designing to RUS standards, they should verify what values are 
correct per the latest RUS documents. 

It is left to the user to determine if these values are appropriate and sufficient for the 
conductor selected and the operating conditions. For example, these limits and loads may 
need to be modified for all-aluminum conductors to prevent vibration, or loading 
conditions may be modified for operating conditions such as extreme ice and wind loads. 

Temp Ice Wind Tension Temp Ice Wind Tension Temp Ice Wind Tension
°F In lb/ft2 % or lb °F In lb/ft2 % or lb °F In lb/ft2 % or lb
30 9 0.60 1 15 0.25 4 0.60 1 0 0.5 4 0.60 1
30 32 0.25 32 0.5
60 0.35 1 0 -20
60 0.25 2 15 0
60 2 30 30
90 60 0.35 1 60 0.35 1

120 60 0.25 2 60 0.25 2
167 60 2 60 2
212 90 90

120 120
167 167
212 212

NESC Heavy Load

Code

NESC Tension Limits
NESC Light Load

Code

NESC Medium Load

Code

Temp Ice Wind Tension Temp Ice Wind Tension Temp Ice Wind Tension
°F In lb/ft2 % or lb °F In lb/ft2 % or lb °F In lb/ft2 % or lb
30 9 0.50 1 15 0.25 4 0.50 1 0 0.5 4 0.60 1
30 0.333 1 32 0.25 32 0.5
30 0.25 2 0 -20
30 2 15 0.333 1 0 0.333 1
60 15 0.25 2 0 0.25 2
60 15 0
60 30 30
90 60 2 60 2

120 90 90
167 120 120
212 167 167

212 212

NESC Heavy Load

Code

Customary Tension Limits
NESC Light Load

Code

NESC Medium Load

Code
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5.2.3 California  
The California Heavy and Light Loadings for Overhead Conductors are shown in the 
tables below. Tension limits shown are % RTS. If the user is designing to California 
standards, they should verify what values are correct per the latest California standards 
documents. 

It is left to the user to determine if these values are appropriate and sufficient for the 
conductor selected and the operating conditions. For example, these limits and loads may 
need to be modified for all-aluminum conductors to prevent vibration, or loading 
conditions may be modified for operating conditions such as extreme ice and wind loads.

Temp Ice Wind Tension Temp Ice Wind Tension
°F In lb/ft2 % or lb °F In lb/ft2 % or lb
25 8 0.60 1 0 0.5 6 0.60 1
25 32 0.5
60 0.25 1 -20
60 0.25 2 0
60 2 30
90 60 0.35 1
120 60 0.25 2
167 60 2
212 90

120
167
212

California Heavy Load

Code

NESC Tension Limits
California Light Load

Code

Temp Ice Wind Tension Temp Ice Wind Tension
°F In lb/ft2 % or lb °F In lb/ft2 % or lb
25 8 0.50 1 0 0.5 6 0.50 1
25 0.333 1 32 0.5
25 0.25 2 -20
25 0 0.333 1
60 2 0 0.25 2
90 0
120 30
167 60 2
212 90

120
167
212

California Heavy Load

Code

Customary Tension Limits
California Light Load

Code
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5.3 Gallop Load 
Clicking on the Gallop Load button in the Load Selection panel will insert the loads 
shown below into the Load Table. These are required to calculate the Galloping Ellipses.  

---------------------------------------------------------------------------------------------------------
NOTE 

The NESC and Customary Heavy loads already include the gallop load 
conditions.

---------------------------------------------------------------------------------------------------------

Refer to the Gallop module section in the Sag & Tension Data screen chapter for more 
information on galloping calculations. 

5.4 Creep Load  
To make a standard check for creep, click on the Creep Load button in the Load
Selection panel. SAG10 will add a Load Table entry of :  

Any row with a zero value for the Tension entry and a 2 for Code entry will allow the 
program to check for creep. If all such entries are removed, creep will not be checked, 
and incorrect data may result. In such a case, the output also will read Creep is NOT 
Considered.

If the final sag is controlled by creep, the output will read Creep IS a Factor. If the final 
sag is controlled by the ice and wind from one of the load cases, the output will read 
Creep is NOT a Factor. 

5.5 Printing the Load Table 
Saved Loading Table files with a .LOD extension can be opened with a word processor, 
such as MS WordPad or Word. Highlight the text and select a fixed pitch font such as 
Courier New. If you want the table headings, you will have to type them in manually. 
When you have chosen your font and headings, print from the word processor.  

Temp Ice Wind Tension
°F in Psf % or lb

60.0 2

Creep Load

Code

Temp Ice Wind Tension
°F in Psf % or lb

32.0 0.50

30.0

Gallop Loads

Code
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Sag & Tension Data Screen

Data Screen 

Creep Messages in Data Screen 

Data Screen Upper Toolbar Controls 

Data Screen Lower Toolbar Controls 
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6 Sag & Tension Data Screen  

---------------------------------------------------------------------------------------------------------
NOTE

The toolbar in the SAG10 Sag & Tension Data screen offers many 
important project calculation choices. For details, refer to the Data Screen
toolbar controls section below.  

---------------------------------------------------------------------------------------------------------

6.1 Data screen  
When you run sag and tension calculations, either from the Calculate Sag & Tension
button on the Main Menu screen, or from the Main Menu toolbar→Run menu, the 
SAG10 program generates a Sag & Tension Data screen to display the output. You can 
use the scroll bars to view data that extends off the screen.  

If you selected the Pause between Spans option, either in the Ruling Spans panel of the 
Main Menu screen, or in the Main Menu toolbar→Run menu, the toolbar at the top of 
the Sag & Tension Data screen will contain the Next Span option. Clicking on Next
Span will allow SAG10 to calculate each span until the last span is displayed.  

The SAG10 Main Menu screen toolbar→Tools→Options→Also Output Results to
panel lets you send sag and tension output to either a printer or a file, as well as the Sag 
& Tension Data screen when a calculation is run. If you select this, the output of 
calculations for the modules listed in the Sag & Tension Data screen toolbar→Modules 
menu selection: Stringing, Offset Clip, RS Variation, Gallop and Clash are also sent to 
the printer or file.  

Refer to the SAG10 Main Menu screen toolbar→Page Setup menu selection for options 
such as adding your Company name and date to the page header. 

6.2 Creep messages in the Data Screen  

6.2.1 Extrapolated curve message.  
If your output indicates that SAG10 has had to extrapolate a stress-strain curve beyond 
the point where it may be valid, this message will appear. This may happen anytime large 
mechanical loadings are placed on a conductor, particularly in longer spans, and very 
large strains are encountered. SAG10 estimates the stress-strain curve in these situations 
to the best of its ability and completes the calculation. However, the user should be aware 
that this is occurring as it may affect the accuracy of the results. 

6.2.2 Creep messages and critical tension 
• If your output indicates that Creep is a Factor, it means that final sag and tension are 

controlled by the elongation caused by the long-term creep of the conductor.
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• If your output indicates that Creep is Not a Factor, it means that final sag and 
tension are controlled by the elongation caused by one of the loaded conditions.

• If your output indicates that Creep is Not Considered, it means that the user has 
bypassed the normal creep check by leaving out the 60°F, Code 2 load case from the 
Loading Table and that the output is therefore probably incorrect. 

For hotter climates, the normal creep check condition of 60-0-0-0-2 may be changed to a 
higher temperature, such as 70-0-0-0-2. Likewise, for a colder climate, the normal creep 
check condition may be changed to a lower temperature, such as 50-0-0-0-2. The 10 year 
creep load will be applied at the highest temperature in the loading table with a no load, 
no tension limit and a code 2 entry. 

The critical tension (Tcr) is the tension corresponding to the intersection between final 
modulus curve and 10 years creep curve in the conductor stress-strain chart.  

If T>Tcr, then the 10 year creep curve strain is greater than the final modulus curve 
strain, and the final sag and tension will be based on the 10 year creep curve. The Data 
Screen message will read: Creep is a Factor.

If T<Tcr, then the 10 year creep curve strain is less than the final modulus curve strain, 
and the Final sag and tension will be based on the final modulus curve. The Data Screen
message will read: Creep is Not a Factor. 

6.3 Data Screen upper toolbar controls 
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6.3.1 Action 

Export to Printer 
This menu item displays the standard MS Windows printer setup and selection window.

Export to File 
This menu item saves the report file to a location you specify.  

Set up Fonts 
This menu item opens the SAG10 Font window. For details, refer to the Main Menu
screen toolbar→Setup menu section.  

Explore Folder 
This menu item lets you browse for a file or folder location you specify.  

Exit to Main Screen 
This menu item closes the Sag and Tension Data screen and returns you to the SAG10 
Main Menu screen.

6.3.2 Edit 

Cut, copy, paste to clipboard
These menu items implement the standard MS Word commands.  

Edit with WordPad 
This menu item opens a Word window and loads the output report for editing.

6.3.3 View 

Sag Curves 
This menu item opens the Catenary Curve Parameters window.
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This window lets you set parameters for the sag curve display.  

Catenary Curve Parameter window controls  
• Sag Curve settings for Initial or Final sag 
• Curve Type settings for Catenary or Parabolic curve.  
• Adjustable Horizontal and Vertical scales  
• You can specify a Ground Clearance for the sag curve. If you enter a value of 0, no 

ground clearance will be shown with the sag curve  
• Set a Left Offset for the sag curve to allow better viewing of flatter sag curves.  
• Checking the Show Gridlines box will put gridlines on the screen, printed and DXF 

output. This may aid in alignment of the sag curves with your own grid system. 
• The View Graph button opens the Catenary Curve screen. You can print or plot the 

image directly, or transfer it to a graphics program for further editing. Toolbar options 
in the Catenary Curve screen toolbar:  

o Save as BMP file saves the curve to a .BMP file. 
o Print/Plot will send the curve to the default printer or plotting device. 
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o Page Setup allows you select print options such as portrait or landscape 
print orientation in a standard MS Word printer setup window.  

o Return takes you back to the Catenary Curve Parameter screen. 

• The DXF File button saves the sag file as a .DXF file in a location you specify. A 
DXF file can be imported into most CAD programs. Typical uses would be to 
generate a sag template overlaid with other conductors, or to import the sag curve into 
a drawing containing some ground profile for structure spotting. 

• The Cancel button closes the Catenary Curve Parameters screen and returns you to 
the Sag & Tension Data screen.

6.3.4 Stringing module  
Selecting this option from the Sag & Tension Data screen toolbar Modules list will open 
the Stringing Temperatures screen.  

Stringing Spans 
You can enter multiple spans within the ruling span, or select up to 40 individual spans. 
The number of spans times the number of temperatures may not exceed a total of 1880.  
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Calculate Ruling Span from Span List
You can also retrieve a span list from a .spn file created and saved in the Ruling Span 
Calculation screen (Refer to the Main Menu toolbar→Run menu section). If this box is 
checked, SAG10 will calculate a ruling span for the list of spans used. 

Sum Cable Lengths box 
If you check the Sum Cable Lengths box, the Sag &Tension Data screen will show the 
sum of the level ground catenary lengths for all of the spans listed and for the range of 
selected stringing temperatures and corresponding horizontal tensions. SAG10 will 
calculate one length for each temperature and tension. 

Stringing Temperatures 
You can enter up to 30 stringing temperatures. The stringing temperatures you enter are 
independent of the temperatures you selected for the normal sag and tension calculation.  

The only unloaded temperatures required in the normal sag and tension calculation are 
temperatures with controlling conditions, such as 60-0-0-2 for creep check, checking cold 
temperature for NESC or Customary tension limits, and/or high temperature sag.  

The stringing temperature values you enter will be retained for the entire SAG10 session, 
and are saved with the Project file. 

Condition
If you have chosen Marker balls or Use as a Messenger in the Conductor Selection
screen (For more details, refer to the Conductor Selection Screen chapter.), Initial will 
calculate without balls or cables, and Final will calculate with balls or cables attached. 
This will let you string the bare wire before attaching balls and cables, and then check the 
final sag after attachment.  

If you are stringing pre-assembled aerial cable, enter the data without balls or cables. The 
Stringing Sag Table will be output as Initial Sag with the attached cable load. (For more 
details, refer to the Conductor Selection Screen chapter.) 

Final W/Load will calculate with balls attached. This selection will generate stringing 
sag tables using all of the temperatures with ice or wind loading. 

Horizontal tensions are, by definition, the same in all spans within a ruling span section. 
SAG10 calculates and stores the horizontal tension for each temperature needed in 
constructing a stringing chart. Stringing sag tables are not available when running 
elevated temperature creep. 
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Units
• The default stringing sag output is Ft-In for English Units. Ft-In allows the output to 

be shown in feet and inches. Inches shows the output in inches only.  
• The setting will default to Decimal for Metric Units. Decimal units are feet for 

English and meters for Metric. 
• 3rd and 5th Return Wave will generate stringing sag output as the time in seconds 

for sagging done by stopwatch. 

6.3.5 Offset Clip module 
Insulator offsets and sag corrections are sometimes needed in rough terrain because the 
conductor, strung over "frictionless" sheaves, tends to run downhill. The result is that the 
conductor will come to equilibrium with sag greater than chart sag in the lower spans and 
less in the upper spans. The stringing sheaves usually swing toward the uphill spans.  

The SAG10 offset clipping program uses techniques presented in AIEE Paper 59-900, 
"Sag-Tension Computations and Field Measurements of Bonneville Power 
Administration" by Paul F. Winkelman. 

Required data
You will need to know the following factors: ruling span, horizontal stringing tension, 
stringing temperature, maximum design tension, loading-ice, wind, temperature, bare 
weight, area and modulus. Many of these factors are already part of SAG10.

The program asks for elevation, station and structure number. You must also know the 
direction of pull. The printout produces positive or negative insulator offsets and sag 
corrections by structure number. 

Create a file
You will need to create a file in a text editor that has ASCII output. Set the file extension 
to .CLP. In the file, each structure will have its own line with the following information, 
in this order, separated by commas:  
• Elevation
• Station back 
• Station ahead (Set to 0 if there is no equation station.) 
• Structure identification, enclosed in single quote marks  

A sample file called SAMPLE.CLP appears below. The example shows the pull from 
Structure 1-1 to 1-12. Structure 1-6 is a sample of an equation station.  
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Sample clipping data file (sample.clp) 

Offset Clipping run procedure
1. Create a .clp file as described above. 
2. Create and execute a sag and tension run for the ruling span in which the offset 

clipping will be used. 
3. In the Sag and Tension Data screen toolbar, select Modules→Offset Clipping.
4. A standard Open File window will appear. Select the file you created in step #1. 
5. When you click on Open in the Open File window, the Offset Clipping screen 

will appear.  

The most recently calculated Ruling Span is displayed as the first input. If you 
choose that Ruling Span and a stringing temperature from the most recent Sag and 
Tension run, then the correct Horizontal Tension will be offered as the third input. 

6. Click on the OK button. The Offsets will appear on the Sag & Tension Data
screen. 

1951,107253,0,'Str # 1-1' 
1851,107353,0,'Str # 1-2' 
1941,107453,0,'Str # 1-3'  COLUMN 1 = Elevation 
1851,107553,0,'Str # 1-4' 
1051,107653,0,'Str # 1-5'  COLUMN 2 = Station Back 
1921,107753,107783,'Str # 1-6' 
1971,107853,0,'Str # 1-7'  COLUMN 3 = Station Ahead ( Only >0 if equation station) 
1981,107953,0,'Str # 1-8' 
1955,108053,0,'Str # 1-9'  COLUMN 4 = Structure No. 
2051,108153,0,'Str # 1-10' 
1651,108253,0,'Str # 1-11' 
1451,108353,0,'Str # 1-12' 

Southwire Sag10 User’s Manual v3.10.6Southwire Sag10 User’s Manual v3.10.7



63  Southwire Sag10 User’s Manual v3.10 

6.3.6 Ruling Span Variation module 
This module calculates the variation in sags and tensions when spans of differing lengths 
see large temperature excursions.

Causes of sag and tension variations
Between deadend structures, there are typically a variety of different span lengths. The 
ruling span is a mathematical number that represents a best approximation of the average 
characteristics that will occur within each of those spans. At initial stringing temperature, 
the horizontal tension is the same for all of the spans, assuming the conductor is pulled in 
evenly across the various spans. However, the further the temperature deviates from the 
stringing temperature, and the further a span-length varies from the ruling span, the 
greater the variation in sag and tension.

These variations are normally small enough to fall within the safety margin allowed in 
line design. However, at elevated or cold temperatures and with large span variations, 
these variations may be large enough that they should be considered during line design. 
This section allows the user to become aware that certain spans may have more sag and 
other spans may have more tension than was calculated by the ruling span sag and 
tension data – and to quantify those differences.

Calculations are limited to suspension insulators  
These calculations apply only for suspension insulator systems, where the insulators are 
free to swing, limited only by gravity. Fixed insulators, such as post insulators, would 
have less change in sag and tension and are not calculated here. Calculating the exact 
stiffness of the support structure would be required, numbers that would be difficult to 
obtain. 

Running ruling span variations
To use this module: 
1. Select Modules→RS Variation in 

the Sag & Tension Data screen
toolbar. A standard Open File
window will open. Select either a 
.SPN file created in Ruling Span 
Calculations screen or a .CLP file 
from clipping offset calculations. 
When you click on Open in the 
Open File window, the Variations
in Ruling Span Data screen will 
appear. 

2. Select the correct stringing 
temperature from the Stringing
Temp drop-down menu.  

3. Select the temperature to compare 
with in the Temp/Load to 
Compare drop-down menu. You 
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can view the extreme variations by selecting an elevated temperature, a cold 
temperature, or an ice load condition for comparison.  

4. Set the comparison condition by clicking on Initial (for cold temperature or ice load 
comparison) or on Final (for elevated temperature comparison).  

5. Enter the length and weight of the entire string of suspension insulators.  
6. Click on the OK button, and the Variations in Ruling Span calculations will appear 

on the Sag & Tension Data Screen.  

6.3.7 Gallop module 

SAG10 will calculate galloping by three methods, the two common methods of Davison 
and Toye, and calculations by C.B.Rawlins, based upon his IEEE paper. 

Add gallop loads
Before you can do galloping calculations, you must have gallop load entries in your load 
file:  
• One line showing 30 Deg. F., no ice, no wind  
• One line showing 32 Deg. F, 0.5 ice, no wind.  
Clicking on the Gallop Load button in the Load Selection panel of the Edit Load Table
screen will add these entries to the load table automatically.  
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Running gallop calculations  
Select Modules→Gallop in the Sag and Tension Data screen toolbar and the Galloping
Data Entry screen will open.  

The Galloping Data Entry screen displays current conductor information, applicable sag 
and tension calculation results, and prompts for additional information. 

Horizontal Span: The displayed value defaults to the current ruling span. This may be 
made larger or smaller, to match specific span lengths within the ruling span. 

Suspension Insulator Length: If this value is greater than zero, the Rawlins calculations 
will create a Ymax (peak to peak amplitude) result for suspension structures, and an 
insulator length will be shown in the graphical display. 

Structure Spring Constant: This value is used in calculating the Ymax value in the 
Rawlins calculations. The value will vary from the sample entry of 21900 and should be 
determined specifically for your structures. For more details, refer to Appendix R, 
"Rawlins Galloping” in the White Papers section at www.SAG10.com/documentation.

The Davison and Toye formulas give ellipse dimensions recommended for use in design, 
based on observations available at the time they were published. These dimensions have 
been widely applied in designing clearances for galloping. A more recent, larger 
collection of field observations provides the basis for the Ymax values given in SAG10. 

Designers are cautioned that a wide variety of ellipse orientations and eccentricities occur 
in practice. Refer to Fig. 4-6 of EPRI's Transmission Line Reference Book, "Wind 
Induced Conductor Motion" for information on the ranges of variation. 

When you click on 
the OK button in the 
Galloping Data 
Entry screen, the 
Analysis of 
Conductor
Galloping screen
opens. This window 
shows the results of 
the Davison, Toye 
and Rawlins 
galloping
calculations.  
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If suspension insulator length prompted for in the Galloping Data Entry screen is set to 
zero, the Rawlins results for suspension insulators will show N/A. If M` has a value, but 
Ymax indicates N/A, it means that the value for Ymax is outside of the range of test data 
available in the galloping study in Rawlins IEEE paper. No input is required at this 
screen.

If you click on the OK button in the Analysis of Conductor Galloping screen, the 
Graphic Display of Galloping screen will open.  

To display a graphical layout of the galloping ellipses, you will need to enter the 
requested data. Click on the arrow to the right of the Qty of Locations: box to select a 
display of 1 to 4 conductors. An equal number of pairs of attachment point boxes will be 
displayed, (X1,Y1) thru (X4,Y4).
For more details, refer to Appendix I, “Galloping Attachment Locations" in the White 
Papers section at www.SAG10.com/documentation.

Galloping loops may be graphed as either Single loop (Davison) or Double loop (Toye).  

Clicking on the DXF File button will open a standard File Open window where you can 
browse for a location to create a DXF file that can be imported into most CAD programs. 
A typical use for this would be to overlay the Galloping Ellipses from more than one 
conductor with the image of a powerline structure.  

If you have two dissimilar structures, such as a suspension tangent and a deadend 
structure, or a horizontal phase layout that rolls into a vertical layout, and you want to 
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determine the midspan galloping performance, check the Span Between 2 Dissimilar 
Structures box. The 2nd Structure Attachment Points screen will be added to the 
Graphic Display of Galloping screen.  

In the example shown, the first structure is horizontal suspension and the second is a 
vertical deadend structure. The resulting graphic output is equivalent to two structures 
with attachment points that are an average of the X and Y coordinates of the two 
structures, and an average of the attachment point suspension lengths. 

When you click on the View Graph button, the graphic display of the galloping ellipses 
is created.  
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You can print or plot this image directly, or transfer it to a graphics program for further 
customizing, such as adding to or removing part of the image, setting margins, and/or 
rescaling before printing/plotting. 

Galloping graphic display toolbar controls

Print/Plot will send the graphic image to the printer or plotter selected in Print Setup. 

Print Setup opens a standard printer setup and selection window. You can select the 
printer or plotter you want to use here.

---------------------------------------------------------------------------------------------------------
NOTE

When returning to the Sag & Tension Data screen, the output will continue 
to print in the direction that was most recently set. Be sure to reset the 
print direction prior to leaving this area to whatever direction may be 
required for the next print operation. 

---------------------------------------------------------------------------------------------------------

Print Scale opens a window that shows the smallest ratio that will fit on the currently 
selected printer/plotter paper. A larger number creates a smaller image. Try a scale such 
as 80:1 for Portrait and 60:1 for Landscape mode for the example shown. 

BMP will generate a .BMP file of the graphic screen and open a browser window where 
you can select a file name and a storage location.  

6.3.8 Clash module  
Clash Analysis refers to the loaded and unloaded swing and static clearances between 
your chosen conductor and ADSS supported on the same structure, for both initial and 
final state. Conductor suspension insulator string length is taken in consideration. The 
steps required are: 

1) Create or Open a Project file for the chosen conductor with all the appropriate 
loads and ruling span. 

2) Save the Project. 
3) In the Main Menu toolbar, select Run→Sag & Tension.
4) In the Sag & Tension Data screen toolbar, select Modules →Clash.
5) The Clash Analysis Parameters screen will appear indicating that your data has 

been recorded. Click on the Main Menu button to return to return to the Main
Menu screen to enter the ADSS cable data. 
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6) In the Main Menu, click on the Conductor Selection button. Select the ADSS
conductor type and click on the Edit Data button in the Data panel. Enter the 
ADSS cable information. 

7) Change the Load Limits (tension or sag) in the Load Table if that is appropriate, 
but leave the temperature, ice and wind or wind alone conditions exactly the 
same. 

8) Save this second Project file under a different name. 
9) In the Main Menu toolbar, select Run→Sag & Tension.

10) In the Sag & Tension Data screen toolbar, select Modules →Clash for a second 
time. A Clash Analysis Parameters screen with spaces for data entry will 
appear.
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11) Adjust the parameters shown on the screen as needed. Be sure to fill in Insulator
Length if Suspension is selected, and the Horizontal and Vertical offsets 
between the two cables 

12) In the Clash Analysis Parameters window, click on the Report button to view 
the loading cases, cable swing angles, offsets, and conductor to ADSS clearances. 
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13) Click on the Graphic button to view the Clash Diagram screen. This screen 
displays the Transverse and Longitudinal clearances between the two conductors.  
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Options available on the Clash Diagram screen toolbar are:

Output menu choices: 
• Output, Print/Plot will send the image to the Printer or Plotter. 
• Output, Print Setup brings up the Printer Dialog box allows the image to be 

rotated to Portrait or Landscape. 
• Output, Scale allows the scale to be adjusted independently for printed 

output. 

View menu choices: 
• View, Long No Load displays a longitudinal view of the conductors under no 

load conditions. 
• View, Long W/ Load displays a longitudinal view of the conductors with ice 

and wind load conditions. 
• View, Transverse displays a transverse view of the conductors under both 

loaded and unloaded conditions. 
• View, Scale allows the user to rescale the graphic image to an exact scale. The 

default is Best Fit, which is the largest size that will conveniently fit on the 
screen. The Longitudinal and Transverse Views are scaled separately. 

BMP file: 
This will generate a .BMP file of the graphic screen. This graphic image may then 
be stored on disk and/or emailed or otherwise shared as a permanent object. 

Return
This option will close the Clash Diagram screen and return you to the Sag & 
Tension Data screen.

6.4 Data Screen lower toolbar controls 

6.4.1 Return 
The Return button closes the Sag & Tension Data screen and returns you to the SAG10 
Main Menu screen. 

6.4.2 Print 
The Print button sends the sag and tension report to the default printer.  
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6.4.3 Save 
The Save button opens a standard Save File window where you can choose a file name 
and a location to save the output report file.

6.4.4 Copy 
The Copy button opens the default word processor and copies the output report to the 
word processor screen.  

6.4.5 Edit  
The Edit button opens the default word processor and copies the output report to the 
word processor screen for further editing.  

6.4.6 Explore  
The Explore button opens a browser window where you can select a file to open.  
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7 SAG10 Software End User License Agreement 
IMPORTANT: THIS SOFTWARE END USER LICENSE AGREEMENT (“EULA”) IS 
A LEGAL AGREEMENT BETWEEN YOU AND SOUTHWIRE COMPANY. READ 
IT CAREFULLY BEFORE COMPLETING THE INSTALLATION PROCESS AND 
USING THE SOFTWARE. IT PROVIDES A LICENSE TO USE THE SOFTWARE 
AND CONTAINS WARRANTY INFORMATION AND LIABILITY DISCLAIMERS. 
BY INSTALLING AND USING THE SOFTWARE. YOU ARE CONFIRMING YOUR 
ACCEPTANCE OF THE SOFTWARE AND AGREEING TO BECOME BOUND BY 
THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO BE BOUND BY 
THESE TERMS, THEN SELECT THE "CANCEL" BUTTON, DO NOT INSTALL 
THE SOFTWARE AND RETURN THE SOFTWARE TO YOUR PLACE OF 
PURCHASE FOR A FULL REFUND. 

7.1 Definitions 
(a) "Internal Network" means a private, proprietary network resource accessible only by 
employees and individual contractors (i.e., temporary employees) of a specific 
corporation or similar business entity. Internal Network does not include the Internet or 
any other network community open to the public, including but not limited to 
membership or subscription driven groups, associations and similar organizations. 

(b) "Not For Resale (NFR) Version" means a version of the Software, so identified, to be 
used to review and evaluate the Software, only. 

(c) "Software" means the SAG10® software program supplied by Southwire herewith, 
which may also include documentation, associated media, printed materials, and online 
and electronic documentation. 

(d) "Southwire” means Southwire Company and its suppliers and licensors, if any. 

7.2 License(s)
This EULA allows you to: 

(a) Single User License: Install and use the Software on a computer, to be used by a 
single person. This license of the Software may not be shared or used concurrently on 
different computers. 

(b) LAN User License: This license permits a maximum of six users. Install the Software 
on a local area network, in a primary location where the users conduct every day business 
through an Internal Network. 

(c) Site License: This license permits no maximum user limit, Install the Software in a 
single physical location, such as a headquarters building, where many users conduct 
every day business through an Internal Network. 
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(d) Client Server License: This license permits no maximum user limit. Install the 
Software as a hardware/software host centrally located to serve multiple locations 
through an Internal Network. 

(e) Under all licenses, user may make one copy of the Software in machine-readable form 
solely for backup purposes. You must reproduce on any such copy all copyright notices 
and any other proprietary legends on the original copy of the Software. 

7.3 License Restrictions 
(a) Other than as set forth in Section 2, you may not make or distribute copies of the 
Software, or electronically transfer the Software from one computer to another or over a 
network. 

(b) You may not decompile, reverse engineer, disassemble, or otherwise reduce the 
Software to a human-perceivable form. 

(c) You may not rent, lease, or sublicense the Software. 

(d) You may permanently transfer all of your rights under this EULA only as part of a 
sale or transfer, provided you retain no copies, you transfer all of the Software (including 
all component parts, the media and printed materials, any upgrades, this EULA, and the 
serial numbers), and the recipient agrees to the terms of this EULA. If the Software is an 
upgrade, any transfer must include all prior versions of the Software. You may not sell or 
transfer any Software purchased under a volume discount. 

(e) You may not modify the Software or create derivative works based upon the 
Software.

(f) You may not export the Software into any country prohibited by the United States 
Export Administration Act and the applicable regulations. 

(g) In the event that you fail to comply with this EULA, Southwire may terminate the 
license and you must destroy all copies of the Software. 

7.4 Upgrades 
If this copy of the Software is an upgrade from an earlier version of the Software, it is 
provided to you on a license exchange basis. You agree by your installation and use of 
this copy of the Software to voluntarily terminate your earlier EULA and be bound by 
this EULA. You also agree that you will not continue to use the earlier version of the 
Software or transfer it to another person or entity unless such transfer is pursuant to 
Section 3. 
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7.5 Ownership 
The foregoing license gives you limited license to use the Software. Southwire and its 
suppliers retain all right, title and interest, including all copyrights, in and to the Software 
and all copies thereof. All rights not specifically granted in this EULA, including Federal 
and International Copyrights, are reserved by Southwire and its suppliers. 

7.6 Limited Warranty and Disclaimer 
(a) LIMITED WARRANTY. Southwire warrants that, for a period of ninety (90) days 
from the date of delivery (as evidenced by a copy of your receipt): (i) when used with a 
recommended hardware configuration, the Software will perform in substantial 
conformance with the documentation supplied with the Software; and (ii) the physical 
media on which the Software is furnished will be free from defects in materials and 
workmanship under normal use. 

(b) NO OTHER WARRANTY. EXCEPT AS SET FORTH IN THE FOREGOING 
LIMITED WARRANTY, SOUTHWIRE AND ITS SUPPLIERS DISCLAIM ALL 
OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, OR OTHERWISE 
INCLUDING THE WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. ALSO, THERE IS NO WARRANTY OF 
NONINFRINGEMENT, TITLE OR QUIET ENJOYMENT. IF APPLICABLE LAW 
IMPLIES ANY WARRANTIES WITH RESPECT TO THE SOFTWARE, ALL SUCH 
WARRANTIES ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE 
DATE OF DELIVERY. NO ORAL OR WRITTEN INFORMATION OR ADVICE 
GIVEN BY SOUTHWIRE, ITS DEALERS, DISTRIBUTORS, AGENTS OR 
EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE 
SCOPE OF THIS WARRANTY. 

(c) (USA ONLY) SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED 
WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. THlS 
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO 
HAVE OTHER LEGAL RIGHTS THAT VARY FROM STATE TO STATE. 

7.7 Exclusive Remedy 
Your exclusive remedy under Section 6 is to return the Software to the place you 
acquired it, with a copy of your receipt and a description of the problem. Southwire will 
use reasonable commercial efforts to supply you with a replacement copy of the Software 
that substantially conforms to the documentation, provide a replacement for defective 
media, or refund to you your purchase price for the Software, at its option. Southwire 
shall have no responsibility if the Software has been altered in any way, if the media has 
been damaged by accident, abuse or misapplication, or if the failure arises out of use of 
the Software with other than a recommended hardware configuration. 
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7.8 Limitation of Liability 
(a) NEITHER SOUTHWIRE NOR ITS SUPPLIERS SHALL BE LIABLE TO YOU OR 
ANY THIRD PARTY FOR ANY INDIRECT, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF 
BUSINESS, LOSS OF PROFITS, BUSINESS, INTERRUPTION OR THE LIKE), 
ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE OR THIS 
EULA BASED ON ANY THEORY OF LIABILITY INCLUDING BREACH OF 
CONTRACT, BREACH OF WARRANTY, TORT (INCLUDING NEGLIGENCE), 
PRODUCT LIABILITY OR OTHERWISE, EVEN IF SOUTHWIRE OR ITS 
REPRESENTATIVES HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES AND EVEN IF A REMEDY SET FORTH HEREIN IS FOUND TO HAVE 
FAILED OF ITS ESSENTIAL PURPOSE. 

(b) SOUTHWIRE'S TOTAL LIABILITY TO YOU FOR ACTUAL DAMAGES FOR 
ANY CAUSE WHATSOEVER WILL BE LIMITED TO THE GREATER OF $500 US 
DOLLARS OR THE AMOUNT PAID BY YOU FOR THE SOFTWARE 
THATCAUSED SUCH DAMAGE. 

(c) (USA ONLY) SOME STATES DO NOT ALLOW THE LIMITATION OR 
EXCLUSION OF LIABILITY FOR INCIDENTAL OF CONSEQUENTIAL 
DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY 
TO YOU AND YOU MAY ALSO HAVE OTHER LEGAL RIGHTS THAT VARY 
FROM STATE TO STATE. 

7.9 Basis of Bargain 
The Limited Warranty, Exclusive Remedies and Limited Liability set forth above are 
fundamental elements of the basis of the agreement between Southwire and you. 
Southwire would not be able to provide the Software on an economic basis without such 
limitations. 

7.10 (Outside of the USA) Consumer End Users Only 
The limitations or exclusions of warranties and liability contained in this EULA do not 
affect or prejudice the statutory rights of a consumer, i.e., a person acquiring goods 
otherwise than in the course of a business. 

7.11 General Provisions 
The internal laws of the State of Georgia shall govern this EULA, without giving effect to 
principles of conflict of laws. This EULA contains the complete agreement between the 
parties with respect to the subject matter hereof, and supersedes all prior or 
contemporaneous agreements or understandings, whether oral or written. All questions 
concerning this EULA shall be directed to: Southwire Company, P.O. Box 1000, 
Carrollton GA 30119, Attention: SAG10 Support. 

Southwire Sag10 User’s Manual v3.10.6Southwire Sag10 User’s Manual v3.10.7



79  Southwire Sag10 User’s Manual v3.10 

7.12 Third Party Software 
(a) Third party trademarks, trade names, product names and logos may be the trademarks 
or registered trademarks of their respective owners. 

(b) Copyright (C) by Southwire Company and its Licensors. All Rights Reserved. 
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Appendix – Reference Materials
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8 Appendix - Reference materials  
The following white papers and referenced materials are available online at 
www.sag10.com/documentation.

File Name File Size 
B List of Stress-Strain Charts.pdf 27 KB 

C Notes for Bates Spotting Program.pdf 50 KB 

D Notes for Metric Users.pdf 25 KB 

E Error Messages.pdf 73 KB 

F Plotter Cable Information.pdf 47 KB 

G10 Non-Supporting Cable Example.pdf 41 KB 

G11A Determining Data on One Span_Original Design Not Known.pdf  53 KB 

G11B Determining Data on One Span_Original Data Known.pdf 47 KB 

G12 Offset Clipping Example.pdf 25 KB 

G13 Percent RTS_ HW or Horz & Vert Sag Example.pdf 50 KB 

G1A Stringing Sag Example.pdf 38 KB 

G1B Stringing Sag Example.pdf 39 KB 

G2 Separate Steel & Aluminum Example.pdf 46 KB 

G3 Elevated Temperature Example.pdf 47 KB 

G4 Extra Heavy Load Control Example.pdf 27 KB 

G5 Common Point Example.pdf 39 KB 

G6 Rime Ice Example.pdf 37 KB 

G7 Metric Example.pdf 35 KB 

G8 TP Conductor Example.pdf 36 KB 

G9 Marker Ball Example.pdf 39 KB 

H Stringing Sag Calculations.pdf 28 KB 

I GallopingAttachmentLocations.pdf 36 KB 

J Inclined Span Sag Example.pdf 73 KB 

K Sketch - Use of Offsets.pdf 27 KB 

L1 Toye and Davison Clearances.pdf 433 KB 

L2 Toye and Davison Clearances update.pdf 41 KB 

P Examples for AFL-ADSS Cables.pdf 167 KB 

Q Toye and Davison Galloping.pdf 131 KB 

R Analysis of galloping field obsevations.pdf 906 KB 

R Rawlins Galloping.pdf 895 KB 

S Update of galloping field obsevations.pdf 198 KB 

T Galloping Ellipses Plot.pdf 24 KB 

V Theory of Compressive Stress in Aluminum of ACSR.pdf 362 KB 

W Effects of Tangent Support Stiffness on Sags at High Temperature.pdf 236 KB 

X Limitations of Ruling Span Method at HiTemp.pdf 459 KB 

Y Some Effects of Mill Practive on Stress Strain of ACSR.pdf 731 KB 
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